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MỤC 

TIÊU

KHÓA

HỌC

1) Vấn đề:

Học viên “Học xong đạt được những kĩ năng nào ?”

2) Sau khi học xong:

➢ Tạo và quản lý bài trình chiếu hoàn chỉnh từ đầu

➢ Soạn nội dung slide rõ ràng, đúng bố cục

➢ Chèn và định dạng văn bản, hình ảnh, bảng biểu, biểu đồ

➢ Sử dụng theme, layout, màu sắc, font chữ phù hợp

➢ Chèn âm thanh, video vào bài trình chiếu

➢ Trình chiếu và xuất file phục vụ học tập, báo cáo, thuyết trình

Tóm lại: Học viên có thể tự thiết kế và trình bày các bài PowerPoint 
cơ bản, chuyên nghiệp, đáp ứng nhu cầu học tập và công việc văn phòng.

Work from home Wi-Fi with solid fill
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CHƯƠNG I: GIỚI THIỆU VỀ POWERPOINT CƠ BẢN

CHƯƠNG I: GIỚI THIỆU VỀ POWERPOINT CƠ BẢN

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 1: Tạo – Lưu – Mở Bài Trình Chiếu

Bài 2: Giao Diện Trình Chiếu PowerPoint

Work from home Wi-Fi with solid fill
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Người mới thường bỡ ngỡ khi mở PowerPoint, không biết các tab, 

công cụ và chức năng cơ bản nằm ở đâu để bắt đầu tạo bài trình chiếu.

2) Sau khi học xong:

Học viên nhận diện được giao diện làm việc, biết cách tạo – lưu – mở 

file và có nền tảng để tiếp tục các chương sau.

Work from home Wi-Fi with solid fill
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TẠO 

FILE

Bài 1.1: Tạo File

Cách 1: Nhấn vào tìm kiếm Windows → Nhập PowerPoint → Chọn

Blank Presentation

Cách 2: Tại màn hình Desktop chọn PowerPoint → Chọn Blank

Presentation

Work from home Wi-Fi with solid fill
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LƯU 

FILE

Bài 1.2: Lưu File

Lưu ý: trước khi làm việc với trình chiếu thì phải lưu và đặt tên cụ

thể, tránh lỗi file hoặc mất điện giữa chừng dữ liệu sẽ có nguy cơ bị mất.

File → Save As → Thực hiện theo hình phía dưới

Work from home Wi-Fi with solid fill



TIN HỌC SAO VIỆT  Bạch Xuân Hiến ☏ 093 11 44 858  tinhocsaoviet.com Trang 7

GIAO

DIỆN

PPT

THANH

CÔNG CỤ

SLIDE

PHÓNG TO / 

THU NHỎ

Bài 2: Giao Diện Trình Chiếu PowerPoint

Work from home Wi-Fi with solid fill
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CHƯƠNG II: THÊM VÀ QUẢN LÝ SLIDE

CHƯƠNG II: THÊM VÀ QUẢN LÝ SLIDE

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 3: Tạo Slide Mới

Bài 4: Layout (Bố Cục Hiển Thị)

Bài 5: Sắp Xếp – Nhân Bản – Xóa Slide

Work from home Wi-Fi with solid fill
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Người học thường tạo slide một cách rời rạc, không biết cách thêm, 

sắp xếp, sao chép, xóa và quản lý các slide, dẫn đến bài trình chiếu 

lộn xộn, khó theo dõi.

2) Sau khi học xong:

Học viên có thể tạo, tổ chức và quản lý slide một cách khoa học, biết 

cách thêm, sắp xếp và chỉnh bố cục slide, giúp bài trình chiếu mạch 

lạc, rõ ràng và chuyên nghiệp hơn.

Work from home Wi-Fi with solid fill
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Bài 3: Tạo Slide Mới

Cách 1: Chuột Phải Vào Slide → Chọn New Slide →

Cách 2: Nhấn Tổ Hợp Phím Tắt Ctrl + M (Tạo Mới Slide)

Chuột phải vào đây

Work from home Wi-Fi with solid fill
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Bài 4: Layout (Bố Cục Hiển Thị)

Cách 1: Chọn vào Layout → Chọn bố cục phù hợp

Chọn một bố cục hợp lý sẽ giúp làm tăng tính thẩm mỹ và giúp bài trình chiếu

trở nên chuyên nghiệp hơn.

Work from home Wi-Fi with solid fill
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Bài 5.1: Sắp Xếp Slide

Chuột phải vào Slide → Giữ chuột trái kéo thả lên  , xuống

Work from home Wi-Fi with solid fill
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Bài 5.2: Nhân Bản Slide

Chuột phải vào Slide → Chọn → Duplicate Slide

Chuột phải vào đây

Work from home Wi-Fi with solid fill
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Bài 5.3: Xóa Slide

Chuột phải vào Slide cần xóa → Chọn Delete Slide

Work from home Wi-Fi with solid fill
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CHƯƠNG III: VĂN BẢN VÀ ĐỊNH DẠNG CƠ BẢN

CHƯƠNG III: VĂN BẢN VÀ ĐỊNH DẠNG CƠ BẢN

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 6: Chèn Text Box

Bài 7: Định Dạng Chữ (Font - Size – Màu)

Bài 8: Căn Chỉnh Nội Dung Văn Bản

Bài 9: Bullets & Numbering

Work from home Wi-Fi with solid fill
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Nhiều học viên nhập văn bản nhưng không biết căn chỉnh và định 

dạng.

2) Sau khi học xong:

Học viên có thể làm được: Chèn Textbox, đổi Font – Màu, căn chỉnh, 

tạo Bullets, numbering, giúp bài trình chiếu trở nên chuyên nghiệp.

1

Work from home Wi-Fi with solid fill



TIN HỌC SAO VIỆT  Bạch Xuân Hiến ☏ 093 11 44 858  tinhocsaoviet.com Trang 17

Bài 6: Chèn Text Box

Vào thẻ Insert → Tại nhóm Text → Chọn Text Box

Work from home Wi-Fi with solid fill
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Bài 7: Định Dạng Chữ

Chọn văn bản cần Định dạng → Home → Nhóm Font

Trong trình chiếu Powerpoint, việc chọn font chữ và định dạng phù hợp với nội

dung, sẽ giúp phần trình bày trở nên chuyên nghiệp và thu hút người xem hơn.

Work from home Wi-Fi with solid fill
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Bài 8: Căn Chỉnh Nội Dung Văn Bản

Chọn văn bản cần Định dạng → Home → Nhóm Font

Lề trái

Lề giữa

Lề phải

Căn đều

Trong trình chiếu Powerpoint, việc căn lề nội dung sẽ được chú ý hơn, giúp

đoạn trình bày có bố cục và văn bản đẹp hơn.

Work from home Wi-Fi with solid fill
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Bài 9: Bullets & Numbering

Chọn văn bản cần → Home → Chọn Bullets hoặc Numbering

Bullets

Numbering

Trong trình chiếu Powerpoint, việc sử dụng Bullets và Numbering giúp trình

bày nội dung rõ ràng, dễ theo dõi.

Work from home Wi-Fi with solid fill
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CHƯƠNG IV: THAO TÁC CƠ BẢN VỚI HÌNH ẢNH

CHƯƠNG IV: THAO TÁC CƠ BẢN VỚI HÌNH ẢNH

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 10: Chèn Hình Ảnh

Bài 11: Một Số Thao Tác Cơ Bản Với Hình Ảnh

Work from home Wi-Fi with solid fill
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Slide thiếu hình minh họa do học viên chưa biết chèn đối tượng.

2) Sau khi học xong:

Học viên có thể làm được: Chèn ảnh, biết định dạng cơ bản với hình 

ảnh.

1

Work from home Wi-Fi with solid fill
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Bài 10: Chèn Hình Ảnh

Bước 1: Đặt chuột tại vị trí cần chèn

Bước 2: Chọn thẻ Insert

Bước 3: Tại nhóm Images → Chọn Pictures → Chọn This Device…

Bước 4: Chọn thư mục chứa ảnh → Chọn ảnh cần chèn → Chọn Insert

Đặt chuột tại vị trí cần chèn

Chọn ảnh 

cần chèn
Chọn thư mục

Work from home Wi-Fi with solid fill
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Bài 11: Một Số Thao Tác Với Hình Ảnh,

1. Thay đổi kích thước và kiểu hiển thị trong văn bản

(1) Kéo để tăng kích thước

(2) Xoay tròn

(3) Tăng giảm kích thước theo chiều rộng

(4) Tăng giảm kích thước theo chiều cao

Work from home Wi-Fi with solid fill
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2. Di chuyển hình: Chọn viền ngoài, (xuất hiện chùm mũi tên) → Kéo và thả

3. Xóa: Chọn viền ngoài, (xuất hiện chùm mũi tên) → Chọn Delete

4. Nhóm/bỏ nhóm hình ảnh

➢ Chọn các hình cần nhóm → Phải chuột → Group →

➢ Bỏ nhóm: Phải chuột → Ungroup

5. Nhân bản: Chọn hình → Giữ Ctrl → Di chuyển đến vị trí khác

6: Sắp xếp các lớp: Chọn hình cần sắp xếp: Phải chuột →

➢ Bring to Front (Sắp xếp hình nằm trên)

➢ Send to Back (Sắp xếp hình nằm dưới)

Work from home Wi-Fi with solid fill
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CHƯƠNG V: CHỦ ĐỀ CƠ BẢN (THEME)

CHƯƠNG V: CHỦ ĐỀ CƠ BẢN (THEME)

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 12: Theme (Chủ Đề)

Bài 13: Variants (Màu Theo Chủ Đề)

Work from home Wi-Fi with solid fill
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Người học thường thiết kế slide theo cảm tính, màu sắc và bố cục 

không đồng nhất, khiến bài trình chiếu rối mắt, thiếu chuyên nghiệp 

và khó theo dõi.

2) Sau khi học xong:

Học viên có thể thiết kế slide đồng bộ về theme, màu sắc, nền và bố 

cục, để tạo bài trình chiếu đẹp, nhất quán và chuyên nghiệp.

Work from home Wi-Fi with solid fill
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Bài 12: Theme (Chủ Đề)

Vào thẻ Design → Chọn mẫu Theme có sẵn

Sử dụng Theme trong PowerPoint giúp bài trình chiếu đồng bộ màu sắc – bố

cục – font chữ, tạo tính chuyên nghiệp, tiết kiệm thời gian thiết kế và giúp người

xem dễ tập trung vào nội dung.

Work from home Wi-Fi with solid fill



TIN HỌC SAO VIỆT  Bạch Xuân Hiến ☏ 093 11 44 858  tinhocsaoviet.com Trang 29

Bài 13: Variants (Màu Theo Chủ Đề)

Vào thẻ Design → Tại nhóm Variants → Chọn màu phù hợp

Variants cho phép thay đổi nhanh màu sắc, font chữ và hiệu ứng của theme

mà vẫn giữ nguyên bố cục slide.

Work from home Wi-Fi with solid fill
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1. Colors: Thay đổi tổng thể của slide (chữ, nền, hình, biểu đồ)

2. Fonts: Thay đổi nhanh kiểu chữ cho toàn bộ bài trình chiếu

3. Effects: Thay đổi hiệu ứng cho hình khối, bảng, biểu đồ…

4. Background Styles: Thay đổi kiểu nền của slide

Work from home Wi-Fi with solid fill
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CHƯƠNG VI: SỬ DỤNG BIỂU ĐỒ CƠ BẢN

CHƯƠNG VI: SỬ DỤNG BIỂU ĐỒ CƠ BẢN

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 14: Biểu Đồ (Chart)

Bài 15: Tùy Chỉnh Trong Biểu Đồ (Chart)

Work from home Wi-Fi with solid fill
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Người học thường trình bày dữ liệu và quy trình bằng chữ thuần túy, 

khiến nội dung khó hiểu, khó so sánh và kém trực quan.

2) Sau khi học xong:

Học viên có thể sử dụng biểu đồ để trình bày thông tin, quy trình và 

số liệu một cách rõ ràng, trực quan và dễ hiểu hơn trong bài trình 

chiếu.

1
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Bài 14: Biểu Đồ (Chart)

Vào thẻ Insert → Tại nhóm Illustrations → Chart→ Chọn mẫu biểu đồ → Ok

Work from home Wi-Fi with solid fill
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Bài 15: Tùy Chỉnh Trong Biểu Đồ (Chart)

Chọn vào sơ đồ → Tại bảng tính Excel → Điền nội dung

Biểu đồ (Chart): dùng để biểu diễn dữ liệu bằng hình ảnh, giúp so sánh, phân

tích và hiểu số liệu nhanh chóng và trực quan hơn.

Tên cột Giá trị
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1. Thiết Kế Và Định Dạng Biểu Đồ (Chart Design)

Chọn vào sơ đồ → Chọn thẻ ngữ cảnh Chart Design → Tùy chỉnh nội dung

Chart Design: một biểu đồ hiệu quả là biểu đồ truyền tải thông tin rõ hơn cả

lời nói, khiến người xem hiểu ngay mà không cần phải hỏi lại.

1. Thay đổi kiểu biểu đồ

2. Các mẫu biểu đồ có sẵn

3. Bố cục biểu đồ

➢ Add Chart: Thêm thành 

phần hiển thị cho biểu đồ.

➢ Quick Layout: Chọn 

nhanh bố cục biểu đồ

Work from home Wi-Fi with solid fill
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2. Định Dạng Biểu Đồ

Chọn vào sơ đồ → Chọn thẻ ngữ cảnh Format→ Tùy chỉnh nội dung

Format: dùng để định dạng màu sắc, viền, hiệu ứng cho biểu đồ.

1. WordArt Styles: Dùng

để thay đổi màu sắc,

viền và hiệu ứng cho

chữ WordArt.

2. Shape Styles: Dùng để

thay đổi màu nền, viền

và hiệu ứng cho các

hình khối (Shape).

Chọn biểu đồ
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CHƯƠNG VII: ANIMATIONS – TRANSITIONS

CHƯƠNG VII: ANIMATIONS – TRANSITIONS

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 16: Hiệu Ứng Animations Cơ Bản

Bài 17: Hiệu Ứng Chuyển Slide (Transitions)

Bài 18: Áp Dụng Hiệu Ứng Hợp Lý
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Nhiều người làm slide thường làm thêm hiệu ứng theo cảm tính, sử 

dụng không hợp lý, quá nhiều hoặc không đúng chỗ, khiến người 

xem rối mắt, khó theo dõi và mất tập trung vào nội dung chính.

2) Sau khi học xong:

Học viên có thể dùng Animations và Transitions đúng cách, biết 

chọn hiệu ứng phù hợp, giúp slide mượt, rõ ràng và tăng tính 

chuyên nghiệp.

1
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Bài 16: Hiệu Ứng Animations Cơ Bản

Chọn đối tượng → Tại thẻ Animations → Tại nhóm Animation → Chọn mẫu hiệu ứng

CHỌN ĐỐI 

TƯỢNG

Chọn mẫu
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Bài 17: Hiệu Ứng Chuyển Slide (Transitions)

Chọn Slide → Tại thẻ Transitions → Tại nhóm Transition → Chọn mẫu hiệu ứng

Chọn Slide

Hiệu ứng chuyển động
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Bài 18: Áp Dụng Hiệu Ứng Hợp Lý
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CHƯƠNG VIII: THIẾT KẾ SLIDE (LAYOUT)

CHƯƠNG VIII: THIẾT KẾ SLIDE (LAYOUT)

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 19: Bố Cục Slide (Layout)

Bài 20: Các Loại Bố Cục Cơ Bản
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Nhiều slide dù có đủ nội dung nhưng màu sắc rối, bố cục kém và chi 

tiết không phù hợp, khiến bài trình chiếu thiếu thẩm mỹ và khó theo 

dõi.

2) Sau khi học xong:

Học viên có thể kết hợp bố cục, nội dung một cách hợp lý để thiết kế 

slide đẹp, rõ ràng và đúng mục đích trình bày.

1
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Bài 19: Bố Cục Slide (Layout)

Bố cục Slide (Layout) là: cách sắp xếp vị trí tiêu đề, nội dung, hình ảnh và biểu

đồ trên một slide để trình bày thông tin rõ ràng và đẹp mắt.

Vào thẻ Home → Tại nhóm Slides → New Slide → Chọn mẫu Layout

Các mẫu cơ bản

Work from home Wi-Fi with solid fill
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Bài 20: Các Loại Bố Cục Cơ Bản

1. Bố Cục Cơ Bản:

Bố cục cơ bản bao gồm: tiêu đề nằm ở phần trên cùng của slide và nội dung

chính được bố trí ở giữa hoặc phía dưới. Đây là một trong những kiểu bố cục

truyền thống nhưng luôn mang lại hiệu quả cao.

Work from home Wi-Fi with solid fill
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2. Bố Cục Hình Ảnh Chính:

Đối với kiểu bố cục này, một hình ảnh lớn được sử dụng làm nền, trong khi nội

dung văn bản được đặt phía trước với số lượng tối giản. Đây là lựa chọn hoàn

hảo để tạo điểm nhấn thị giác mạnh mẽ.

Work from home Wi-Fi with solid fill



TIN HỌC SAO VIỆT  Bạch Xuân Hiến ☏ 093 11 44 858  tinhocsaoviet.com Trang 47

3. Bố Cục 2 Cột:

Kiểu bố cục này chia Slide thành hai phần ngang nhau hoặc theo tỷ lệ khác

nhau, mỗi phần chứa nội dung độc lập. Đây là cách trình bày hiệu quả khi cần so

sánh hoặc liệt kê thông tin.
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4. Bố Cục Theo Dạng Biểu Đồ:

Kiểu bố cục này sử dụng biểu đồ để trình bày dữ liệu hoặc mối quan hệ giữa các 

yếu tố. Biểu đồ giúp thể hiện thông tin phức tạp một cách trực quan và dễ hiểu hơn.

Nếu không có mẫu sẵn thì

Chọn mẫu trống sau đó tự chỉnh sửa
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CHƯƠNG IX: TRÌNH CHIẾU – XUẤT FILE

CHƯƠNG IX: TRÌNH CHIẾU – XUẤT FILE

I. Mục Đích Nghiên Cứu

II. Nội Dung Nghiên Cứu

Bài 21: Trình Chiếu (Slide Show)

Bài 22: Các Chức Năng Khác Của Slide Show
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MỤC 

ĐÍCH

BÀI 

HỌC

1) Vấn đề:

Nhiều người tạo được Slide nhưng không biết cách trình chiếu hiệu 

quả, dẫn đến việc trình bày kém chuyên nghiệp và khó chia sẻ.

2) Sau khi học xong:

Học viên có thể trình chiếu thành thạo, giúp việc trình bày và chia sẻ 

nội dung trở nên chuyên nghiệp và thuận tiện.

1
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Slide Show là: chế độ dùng để trình chiếu bài PowerPoint toàn màn hình nhằm

trình bày nội dung cho người xem..

Bài 21: Slide Show (Trình Chiếu)

C1: Phía dưới góc phải màn hình → Chọn vào biểu tượng Slide Show

C2: Các phím tắt (Windows):

➢ F5: Bắt đầu trình chiếu từ slide đầu tiên

➢ Shift + F5: Bắt đầu trình chiếu từ slide hiện tại (slide đang chọn)

➢ Esc: Thoát khỏi chế độ trình chiếu (Slide Show)

Các phím tắt (Mac OS):

➢ Bắt đầu: Cmd + Shift + Return

➢ Bắt đầu từ slide hiện tại: Cmd + Return hoặc Cmd + Shift + F5 (tùy phiên bản)
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Bài 22: Các Chức Năng Khác Của Slide Show

From Beginning

Chạy slide từ trang đầu tiên

Khi bấm nút này:

• PowerPoint sẽ trình chiếu

từ Slide 1

• Bất kể bạn đang đứng ở

slide nào

Dùng khi:

• Muốn trình chiếu toàn bộ

bài từ đầu đến cuối

• Thuyết trình chính thức

From Current Slide

Chạy từ slide đang chọn

Khi bấm:

• PowerPoint bắt đầu trình chiếu 

từ slide bạn đang đứng

Dùng khi:

• Bạn đang chỉnh slide 5 → 

muốn xem riêng từ slide 5 trở 

đi

• Kiểm tra hiệu ứng, nội dung 

một phần bài
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CHƯƠNG X: DỰ ÁN CUỐI KHÓA

CHƯƠNG X: DỰ ÁN CUỐI KHÓA

Giáo viên hướng dẫn học viên tải bài thi thực hành cuối khóa

Work from home Wi-Fi with solid fill
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